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Application Note

This application note describes
how to configure the Keysight
Technologies Inc. 89600 VSA
software with Option BHF
custom OFDM modulation
analysis to analyze and
troubleshoot new, custom,
proprietary, generic, or
non-standard OFDM signals.
Example files are developed
and are available for further
examination in the 89600
VSA software’s demo signal
library and Help text. The
only hardware required for
demonstration is a PC.

Introduction
OFDM (Orthogonal Frequency-Division Multiplexing) signals have
gained great acceptance in communications systems due to their
inherent noise immunity and transmission efficiency. But troubleshooting and analyzing these systems, particularly for new, custom,
generic, or non-standard OFDM formats, is difficult. The 89600 VSA
software software with Option BHF custom OFDM modulation analysis provides many data traces and tables to help the OFDM designer,
including those developing multi-user or MIMO systems.
Multi-carrier modulation schemes, such as OFDM, represent significant challenges for those seeking to verify PHY-layer characteristics.
Most OFDM signals are designed to an open commercial standard,
and so are the tools that test them. While traditional spectrum
analysis can measure simpler parameters such as frequency, power
level, and spectral mask, the more in-depth quality measurements
require special capabilities found only in vector signal analysis tools
flexible enough to work with custom OFDM systems.
The 89600 VSA software with Option BHF custom OFDM modulation analysis provides an easy-to-use, text file-driven approach to
describing generic and proprietary OFDM signals requiring that no
special software be developed.
Once the custom OFDM signal is properly described, the 89600 VSA
software’s troubleshooting capability can be brought to bear on it,
including displaying error traces, such as EVM by time or frequency,
IQ constellations, tabular data such as OFDM data burst info displaying EVM, power, modulation format, and resource units assigned
for preamble pilot, and data subcarriers. Error summary information
per channel provides information on EVM (pilot, data, and preamble
EVM), frequency, symbol clock, and common pilot errors, as well as
IQ errors such as offset, quadrature errors, gain imbalance and time
skew.
Statistical information such as CCDF and CDF traces is also available on these signals, even before demodulation begins. In addition,
the 89600 VSA software can operate with data taken from over 30
supported waveform acquisition platforms, including simulation
software, logic analyzers, oscilloscopes, and signal analyzers. This
allows you to examine your custom OFDM signals anywhere in your
block diagram. Automate design verification tests using SCPI or any
supported .NET language.
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OFDM overview

Figure 1. OFDM is a multi-carrier scheme where closely spaced carriers overlap. Nulls
in each carrier’s spectrum land at the center of all other carriers for zero inter-carrier
interference.

OFDM uses a multicarrier scheme to achieve transmission efficiencies (data rate per
Hz of bandwidth) similar to traditional, single-carrier schemes (QPSK, QAM, etc.),
but with better immunity to common channel impairments. It does so by clocking
many carriers simultaneously, but at proportionately slower symbol rates compared
to single carrier modulation (SCM) schemes.
The multi-carrier scheme is robust in the presence of single-frequency interferers and noise, because (unlike SCM) the loss of an individual carrier (or several)
is not fatal to the entire transmission. OFDM is also tolerant of multipath; spectral
dropouts only affect a limited number of carriers, and the OFDM signal structure
lends itself to strong equalization schemes, which can further reduce the effects of
multipath.
It can be made even more tolerant to multipath with the addition of more channels and MIMO signal processing techniques. Using OFDM allows some important
assumptions to be made about the signal for MIMO operation. For example, the
modulation bandwidth for each sub-carrier is small enough to assume the RF path
can be represented by a single complex coefficient.
Multi-carrier signals such as OFDM offer useful benefits for many digital communications applications, but with a tradeoff in signal and design complexity. OFDM
signals are subject to the same sorts of design problems as any vector-modulated
signal, but these can be difficult to uncover and troubleshoot without OFDM-specific signal analysis tools.

Try the 89600 VSA software, for free
Download the 89600 VSA software and use it free for 14 days to make measurements with your analysis hardware, or use our recorded demo signals by selecting File> Recall> Recall Demo> Custom OFDM > on the 89600 VSA software
toolbar.
The signals and configuration files shown in this application note
are all available there.
www.keysight.com/find/89600_trial
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Demodulation Configuration
Before selecting the custom OFDM mode, ensure that the 89600 VSA software’s basic
acquisition parameters are set correctly for the signal under test. Enter the appropriate
center frequency, span, input range, etc., and verify that the entire signal is visible in a
spectrum display. Information on setting up the VSA software is available in the Help text.
Once these basic parameters are entered, you can use the 89600 VSA software to perform CCDF and various other power, time, and frequency measurements, even before you
begin custom OFDM demodulation.
The OFDM examples in this document are based on an 802.11a/g OFDM signal. The
configuration developed in this application note can be used with the 89600 VSA
software example signal found at File> Recall> Recall Demo> Custom OFDM >
CustomOFDM_80211a.htm. Note that no hardware besides the PC is needed to run or
view these signals in demo mode. Further, when setting up measurements for your own
system, you can make measurements on software-based signals such as those developed in MATLAB, or properly formatted .txt files. See the 89600 VSA software Help text
topic on “Supported File Formats” for more information.
The 89600 VSA software Option BHF custom OFDM demodulation software is configured
with the following three steps:
1. Set up the signal for basic spectrum analysis and then enter the high-level FFT
parameters for the OFDM signal under test
2. Describe the detailed signal structure of the 89600 VSA software, in the form of
3-4 configuration files that define each subcarrier in each symbol
3. Configure the measurement setup, e.g. synchronization type, result length, etc.
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Step 1: Enter the basic signal
and FFT parameters

After recalling the basic signal, select MeasSetup > Measurement Type > Custom
OFDM, and then MeasSetup > Custom OFDM Demod Properties. In the Format section of the Format tab properties dialog box, enter the five numeric values shown in Figure
2. These values are specific to the signal under test, and will normally be found in the
early part of its technical standard.
Notes:
– Enter the FFT Length, which must be a power of 2. Maximum FFT size is 216, or
65,536.
– Enter a Guard Interval, usually a value between 1/16 (.0625) and 1/4 (.25). It
must be entered in decimal notation.
– Enter the number of Guard Lower Subcarriers and Guard Upper Subcarriers.
The number of active subcarriers is generally fewer than the FFT size, with 		
empty guard subcarriers allocated on either side of the signal. The number of 		
active subcarriers is usually odd, due to the null subcarrier in the center, and 		
equal quantities on either side. This results in an odd number of guard subcar		
riers. Most standards define the lower guard region with one more subcarrier than the
upper. The 89600 VSA software can handle either case with no problem.

Figure 2. Format section of custom OFDM demodulation properties Format tab,
showing FFT parameters for 802.11a/g OFDM signal.
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Step 2: Define the detailed
OFDM signal format

The OFDM signal is described to the 89600 VSA software via 4 text files:
– The Resource Map file defines the function of each subcarrier in each symbol,
describing whether it is a preamble, pilot, data or null subcarrier
– The Resource Modulation file defines the modulation format expected for each
subcarrier shown in the Resource Map
– The Preamble IQ file defines the expected I and Q values for each preamble
subcarrier
– The Pilot IQ file defines the expected I and Q values for each pilot subcarrier
These are all simple text files, consisting of numeric values separated by spaces, commas, tabs, or CR/LF. The file extension may be .txt or .csv. For clarity, it may be useful to
organize these files with one row of values per symbol, but this is entirely optional. Note
that an example of each of these files is included for use with the simple demo signal,
CustomOFDM_80211a.sdf. Since these are all just text files, you can use any easily available word processor to create or edit them, including Notepad or Microsoft® Word.

Figure 3. Steps for developing the configuration files required to define custom OFDM
signals.
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Resource Map file

This file must contain one value for each active (i.e. non-guard) subcarrier, including
DC. Thus, the map for an 802.11a/g signal (FFT size of 64 with 11 guard subcarriers)
will contain 53 values per symbol.
Each subcarrier value must be one of the following:
Resource type

Meaning

0

data subcarrier

1

pilot subcarrier, known

2

pilot subcarrier, unknown (see “Pilot I-Q File” section)

3

preamble subcarrier

4

null subcarrier

5

unspecified

Table 1. Resource Map file.

Resource type may actually have a value as high as 1023. For certain advanced
configurations (described in the Advanced Topics section) it is treated as a 10-bit
number, with the higher-level bits used to indicate user number, MIMO antenna
number, etc.
Sym

Resource Map file contents

Meaning

0

44344434443444344434443444444434443444344434443444344

1

44344434443444344434443444444434443444344434443444344

Short training sequence:
two symbols duration;
preamble tone every 4th
subcarrier, null in center

2

33333333333333333333333333433333333333333333333333333

3

33333333333333333333333333433333333333333333333333333

4

00000100000000000001000000400000010000000000000100000

Header symbol: 48 data,
4 pilots, 1 null

5

00000100000000000001000000400000010000000000000100000

Data symbol(s): 48 data,
4 pilots, 1 null

Table 2. Example Resource Map file for 802.11a/g OFDM.
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Long training sequence:
two symbols duration,
preamble tone every
subcarrier, null in center

Resource Repeat index

The resource map for most OFDM signals will consist of one or more preamble
symbols, sometimes followed by specialized header symbols, followed by a repeating pattern of similarly-formatted symbols. For these repeating symbols, it is only
necessary to define the pattern once. The Resource Repeat index tells the 89600
VSA software how to loop after it reaches the end of the Resource Map file.

Figure 4. The Resource Repeat index allows you to indefinitely repeat a symbol or
sequence of symbols for easier signal definition.

In the 802.11a/g example of Figure 4, the Resource Repeat index is 5, meaning that
the 5th symbol (counting from zero) is to be repeated indefinitely. If the index were
4, the 4th and 5th symbols would be repeated in sequence, and so on.

Resource Modulation file

This file contains one Resource Modulation value for every subcarrier shown in the
Resource Map file. The values indicate the modulation format expected for each
subcarrier, according to the QAM identifiers defined in Demod Properties. With
these two files, you are free to assign any modulation type to any subcarrier, including, for instance, assigning BPSK to data subcarriers as well as pilot subcarriers.

Resource Modulation file contents

Meaning

00000000000000000000000000000000000000000000000000000

4 preamble symbols, 53 values per
symbol, but all are placeholders
(see Placeholder values section)

00000000000000000000000000000000000000000000000000000
00000000000000000000000000000000000000000000000000000
00000000000000000000000000000000000000000000000000000
11111011111111111110111111011111101111111111111011111

Header symbol: 48 BPSK, 4 pilots,
1 null

44444044444444444440444444044444404444444444444044444

Data symbol(s): 48 64QAM, 4
pilots, 1 null

Table 3. Example Resource Modulation file for 802.11a/g OFDM signal.
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QAM identifiers

Note that the Resource Modulation value does not define the modulation type directly. Rather, it is an index for the QAM Identifier table, which provides an index for
the QAM Level table. Both of these tables are located on the Format tab of Demod
Properties, and can be edited by the user. In the example in Table 4, a Resource
Modulation value of 4 points to the 4th value (counting from zero) in the QAM Identifier table, which is also 4. Then, QAM Identifier = 4 points to the 4th value in the
QAM Level table, which is 6, for 64QAM.

QAM Identifiers

0, 1, 2, 3, 4, 5

Resource Mod. value

QAM Identifier table

QAM Level table

QAM Levels

0, 1, 2, 4, 6, 8

0

0

0 = unknown

1

1

1 = BPSK

2

2

2 = QPSK

3

3

4 = 16QAM

4

4

6 = 64QAM

5

5

8 = 256QAM

Table 4. Default QAM Identifier and QAM Level tables. Here, a Resource Mod value of “4”
indicates 64QAM.

The advantage to this scheme is that large blocks of subcarrier modulation definitions can be changed quickly and easily, without modifying the Resource Modulation file. Table 5 shows how all subcarriers defined as 64QAM can be changed
to16QAM by modifying a single value in the QAM Identifier table. After this change,
Resource Mod value 4 still points to the 4th value in the QAM Identifier table, but
the resulting index into the QAM Level table is now a 3. The third value in the QAM
Level table is 4, for 16QAM.
QAM Identifiers

0, 1, 2, 3, 3, 5

Resource Mod. value

QAM Identifier table

QAM Level table

QAM Levels

0, 1, 2, 4, 6, 8

0

0

0 = unknown

1

1

1 = BPSK

2

2

2 = QPSK

3

3

4 = 16QAM

4

4

6 = 64QAM

5

5

8 = 256QAM

Table 5. Modified QAM Identifier and QAM Level tables.
Resource Modulation value “4” now indicates 16QAM.
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QAM Level

Option BHF custom OFDM supports the following QAM Level values which represent
the listed modulation formats as shown in Table 6.
QAM level

Modulation

QAM Level

Modulation

1

BPSK

6

64QAM

2

QPSK

7

128QAM

3

8PSK

8

256QAM

4

16QAM

9

512QAM

5

32QAM

10

1024QAM

Table 6. Supported modulation formats and associated QAM Level values.

Auto-detecting the
modulation format

A Resource Modulation value set to zero (unknown) is a special case that can
greatly simplify the custom OFDM setup. This value instructs the demodulation
software to detect the format empirically, based on a statistical algorithm. This
algorithm computes a single result (format) for all subcarriers marked as zero, so
it will normally be used for a group of subcarriers, spread across one or more symbols, that all have the same format.

Placeholder values

The Resource Modulation file must always have the same number of values as the
Resource Map file. However, not all Resource Modulation values are actually used
by the demodulation algorithm because some subcarriers have no modulation
(Resource Type 4 or 5) and some are defined in separate I-Q files (Resource Types 1
and 3, see the Preamble IQ and Pilot IQ sections). The Resource Modulation values
provided for these subcarriers will thus be ignored, and can be set to any number desired-- even numbers assigned to other formats. In the example Resource
Modulation file shown in Figure 6, zero is used as a placeholder, even though it
usually signifies an ‘unknown’ format, for in Preamble IQ and Pilot IQ files, the IQ
data implicitly defines the constellation.
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This file contains I and Q values for every preamble subcarrier (Resource Type 3)
shown in the Resource Map file. Each time the demodulation software encounters
a “3” in the Resource Map file, it reads the next two values from the Preamble IQ
file and uses them as the ideal I-Q location for that preamble subcarrier. For correct
demodulation, it is important to not swap the values--I comes first, then Q.

Preamble IQ file

I-Q values are interpreted as being relative to the average constellation power, i.e.
the “constellation reference power,” which is defined as 1.00. A preamble subcarrier
boosted by 3 dB would thus have a magnitude of 1.414, e.g. 0+j1.414, 1.00+j1.00,
etc.
In most OFDM signals, preamble subcarriers are of constant magnitude, and may
or may not be boosted relative to the constellation reference power. The phase of
each preamble subcarrier is usually one of two (BPSK) or four (QPSK) values, and
typically follows a pseudo random bit sequence (PRBS) defined by the standard. All
of this information must be known in order to construct the Preamble IQ file.
The quantity of values in the Preamble IQ file is equal to twice the total number of
preamble subcarriers, summed across all preamble symbols. It contains values only
for preamble subcarriers-- not data, pilot or null subcarriers.
In the following example, the first I-Q pair is read as 1.47 + j1.47, and refers to
the first preamble subcarrier designated by the Resource Map file in Table 2, i.e.
the third subcarrier in the first symbol. Based on these I-Q values, the 89600 VSA
software expects this preamble subcarrier to have a magnitude of 2.03 and phase
of 45 degrees, relative to the constellation reference power.

Preamble IQ file contents

Meaning
Short training sequence
(12 I-Q x 2 symbols

First preamble subcarrier = 1.47 + j1.47
1.47

1.47

-1.47

-1.47

1.47

1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

etc.

1.47

1.47

-1.47

-1.47

1.47

1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

-1.47

etc.

-1.00

0.00

0.00

1.00

-1.00

0.00

0.00

1.00

-1.00

0.00

0.00

1.00

-1.00

0.00

0.00

-1.00

1.00

0.00

etc.

1.00

0.00

1.00

0.00

-1.00

0.00

-1.00

0.00

1.00

0.00

1.00

0.00

-1.00

0.00

1.00

0.00

-1.00

0.00

etc.

Long training sequence
(52 I-Q x 2 symbols
Figure 5. Example Preamble I-Q file for 802.11a/g OFDM signal.
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Pilot IQ file

Similar to the Preamble IQ file, the values in this file provide the ideal I-Q locations for each known pilot (resource type = 1) shown in the Resource Map file. The
quantity of values in this file is thus equal to twice the number of pilots defined in
the Resource Map.

Unknown pilots

In many cases, it will be simpler to define the pilots as unknown (Resource Type
= 2), and specify only the expected constellation shape, e.g., BPSK, and boosting
level. Based on this information, the 89600 VSA software will determine the ideal
states empirically and not require a Pilot IQ file. No knowledge of the Pilot PRBS
sequence is therefore required.
Note that known pilots (Resource Type = 1) allow the demodulation software to
synchronize more reliably under poor signal-to-noise conditions. In addition, the
received pilot PRBS sequence is verified against the sequence defined in the Pilot IQ
file, so it can detect coding errors in the signal under test.
Known pilots can also be used for synchronization, for the case where signals have
no preamble. This is not possible with unknown pilots.
In summary, the choice of known vs. unknown pilots affects the values entered into
the configuration files as shown in Table 7.

Pilot type

Resource Map
value

Pilot I-Q file

Resource
Modulation file values

Known

1

File required; defines
the ideal I-Q states

Specify either actual
modulation format or
“unknown”

Unknown

2

File not required

Specify either actual
modulation format or
“unknown”

Table 7. Description of pilot IQ values as used in resource map.

Notes:
–
–

For BPSK pilots that are rotated to lie entirely on the vertical (Q) axis,
always use an unknown modulation format, and either:
a) unknown pilots; or b) known pilots plus a valid Pilot IQ file.
Unknown pilots are assumed to have magnitudes of 1.00 relative to the
constellation reference power. If they do not, a relative boosting factor must
be specified on the Format tab.
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Step 3: Configure the
measurement parameters

The setup options for the custom OFDM demodulation software are similar to those
provided for the 89600 VSA software’s existing OFDM formats. More complete descriptions can be found in the 89600 VSA software’s Help text. The following items summarize
important setup parameters.

Format tab
Signal is bursted

Check this box for burst or pulsed signals, unless you’re using a continuously transmitting signal (as in early
system development, perhaps). If you select this parameter, you should also set the 3 pulse search parameters on the Time tab’s Details section.

Details: Boosting

By default, the 89600 VSA software assumes that all modulation types are scaled the same way, i.e. their
average power is 1.00. This section of the setup menu allows separate scaling factors for each modulation
type, for unknown pilots, and for each user number (see Advanced Topics).

Time tab
Measurement Interval and
Measurement Offset

These settings allow you to select the number of symbols to be displayed.

Result Length

Selects the number of symbols to be demodulated.

Result Length

If this parameter is set to “automatic,” the 89600 VSA software demodulates only to the end of the current
burst.

Result Length selection

If this parameter is set to “automatic,” the 89600 VSA software demodulates only to the end of the current
burst.

Search Length

This parameter sets the amount of waveform to acquire per measurement. Typically it is recommended that
you set the value equal to two burst “on” times plus one burst “off” time.

Pulse Search enable

If this parameter is enabled, the software automatically aligns the measurement with the rising edge of the RF
envelope. If you do not enable this parameter, use triggering to position the first symbol near the start of the
time record.

Equalizer & Tracking tab
Equalizer Use
Data/Pilots/Preamble

The 89600 VSA software can use some or all of the subcarriers for Equalizer training. This parameter allows
you to choose which of these to use. Note: To analyze an OFDM signal that has no preamble, de-select
Equalizer Use Preamble in this section, and configure the 89600 VSA software for known pilots.

Equalizer Averaging mode

The 89600 VSA software takes channel response data across multiple symbols. This parameter determines
whether the channel response should be averaged using EqualWeight or LeastSquares. Equal weight
averaging is generally more effective at noise reduction, and is recommended unless otherwise required by
the standard.

Track Amplitude/Phase/
Timing

These parameters specify whether the 89600 VSA software tracks amplitude, phase, or timing changes in
the pilot subcarriers. When any parameter is set to true by checking the check box, the Common Pilot Error
trace will show the appropriate parameter tracking. This is useful for troubleshooting signals, as it can often
highlight the major error source.
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Step 3: Configure the measurement parameters (continued)
Advanced tab
Extended Frequency
Lock Range

Checking this setting allows the 89600 VSA software demodulation algorithm to remain locked with a larger
center frequency offset. However, this results in a tradeoff of some degree of noise immunity.

Synchronization mode

This selection controls the type of synchronization used to synchronize to the start of an OFDM burst. The
two available choices are TimeCorrelation and CyclicPrefix. Use TimeCorrelation for traditional preamble or
pilot-based sync. The CyclicPrefix setting may be of value for unknown, missing, or poorly-formed preambles.

Advanced Topics

So far the example signal and measurements discussed dealt with “basic OFDM”
analysis. Option BHF supports more complex OFDM analysis, including multi-user
(OFDMA) and MIMO transmission. The simple 802.11a signal used as an example
does not support either of these. In the examples which follow, appropriate signals
have been used. Note that these are not included in the demo files, but are presented here as simple discussion examples.

Multi-user OFDM
(OFDMA)

In some forms of OFDM, the physical resource (i.e. the set of subcarriers) is shared
among multiple users. Multiple user versions of OFDM are often called OFDMA, for
“Orthogonal Frequency Division Multiple Access.” In these systems, the subcarriers
for one user may have different modulation formats and/or power levels than those
for other users, making it desirable to view measurement results on a per-user basis.
To accomplish this, each subcarrier in the Resource Map can be assigned to an
arbitrary User Number between 0 and 7. The User Number and Resource Type are
entered into the Resource Map as a single 6-bit number, equal to (User Number x 8)
+ Resource Type.

User

User

User

Type

Type

Type

Examples shown:

0

1

1

0

0

0

Resource Type is 000 (= data subcarrier)

000 = User 0 (default)
001 = User 1
010 = User 2 (etc.)

User number is 011 (= 3)
Resource Map value is 24
= (User Number x8) + Resource Type

000 = Data
001 = Pilot
011 = Preamble (etc.)

Table 8. Creating combined User Numbers and Resource Types for use in Resource Map for multi-user systems.
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When programmed for multiple users, the 89600 VSA software’s Data Burst Info
table displays individual results for each user, as shown in Figure 6.

Figure 6. Data Burst Info table, showing results tabulated by User Number.

User numbers are valuable even for non-OFDMA signals in the following ways.
–

When using the unknown modulation format, autodetection is performed 		
separately for each User Number, so that several regions can be autodetected
independently.
– Constellation reference power (i.e. boosting ratio) can be set separately for 		
each user by User Number, enabling measurements of signals with multiple 		
power levels.

15

MIMO analysis

The 89600 VSA software’s Option BHF custom OFDM software can be configured to
recover and analyze up to 8 MIMO transmission streams. This is accomplished using
the same configuration files described earlier in this note, but with certain modifications.
Configuration details depend on the type of MIMO signal being analyzed. This note
deals with 2 types, described in Table 9 For further clarity, examples of each type
currently used are also listed.
MIMO type

Characteristics

Type 1
(non-overlapping)

Any given pilot or preamble subcarrier is transmitted on only one
antenna at a time, and is null on all other antennas. (Examples:
TM
WiMAX , LTE)

Type 2 (overlapping)

All preamble and pilot subcarriers are transmitted on all
antennas at all times. (Example: 802.11n)

Table 9. Description of the 2 MIMO signal types discussed in this application note.

For both types of MIMO signals, it is assumed that any given data subcarrier is
transmitted simultaneously on all antennas, and has the same modulation format
on all antennas. Further, Option BHF custom modulation analysis assumes that all
MIMO modulation performed uses an equal number of receive and transmit antennas, e.g., 2x2, 3x3, etc.

Configuring type 1 MIMO

To further illustrate this class of signals, i.e., non-overlapping, consider the simple
MIMO signal shown in Table 10.
Antenna 0

Antenna 1

Preamble

P x P x P x P x P x

x P x P x P x P x P

Symbol 1

1 0 0 x 0 0 1 0 0 x

x 0 0 1 0 0 x 0 0 1

Symbol 2

x 0 0 1 0 0 x 0 0 1

1 0 0 x 0 0 1 0 0 x

Symbol 3

1 0 0 x 0 0 1 0 0 x

x 0 0 1 0 0 x 0 0 1

Symbol 4

x 0 0 1 0 0 x 0 0 1

1 0 0 x 0 0 1 0 0 x

Table 10. Type 1 MIMO signal description (simplified example).
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Note the non-overlapping preamble tones (P) in the first symbol, and the nonoverlapping pilot tones (1) in the subsequent symbols. The required configuration
file modifications are as follows:

Resource Map file

For each preamble or pilot subcarrier, treat the Resource Type value as a 9-bit
number, with the upper three bits representing the antenna number. Thus, to assign an Antenna Number, add (antenna number x 64) to the Resource Type. When
an Antenna Number is assigned to a resource, the analysis software assumes that
resource is active on that antenna only, and null on all other antennas. The Antenna
Number may change from symbol to symbol.

Ant

Ant

Ant

User

User

User

Type

Type

Type

Examples shown:

0

0

1

0

0

0

0

1

1

Resource Type is 3 (= preamble subcarrier)

000 = Ant. 0 (default)
001 = Ant. 1
010 = Ant. 2 (etc.)

000 = User 0 (default)
001 = User 1
010 = User 2 (etc.)

000 = Data
001 = Pilot
011 = Preamble (etc.)

User number is 0 (default)
Antenna Number is 1
Resource Map value = 67
= (Ant Number x 64) + Resource

Table 11. Creating Resource Type values for multi-antenna, multi-user signals.

For the simplified MIMO signal shown in this Type 1 MIMO example, the modified
Resource Map would appear as follows. Notice how it describes the signals on both
antennas at once.

Resource Map
Preamble

3

67

3

67

3

67

3

67

3

67

Symbol 1

1

0

0

65

0

0

1

0

0

65

Symbol 2

65

0

0

1

0

0

65

0

0

1

Repeat
Table 12. Resource Map for Type 1 MIMO example showing modified values.

17

Resource Modulation file

This file requires no modification. As before, it contains one Resource Modulation
value for each subcarrier shown in the Resource Map file.

Preamble and Pilot IQ files

Because these files also describe multiple signals at once, they will generally have
more entries than a SISO file. Beyond that, the basic rules still apply: include one
I-Q pair, scaled to the constellation reference power, for each preamble or pilot
shown on the Resource Map (omitting data, null and guard subcarriers), and enter
them in the same sequence as they appear in the Resource Map file.
In the simple MIMO Resource Map example used, the preamble tones alternate
between antenna 0 and antenna 1. In the Preamble IQ file, the values alternate the
same way. See Table 13 for an example.

Preamble IQ file:

Iant0’ Qant0’ Iant1’ Qant1’ Iant0’ Qant0’ Iant1’ Qant1’ Iant0’ Qant0’ Iant1’ Qant1’ etc ...

Table 13. Preamble IQ file showing alternating I-Q values for each antenna.

The same is true for the Pilot IQ file, where additional lines are needed because the
pilot sequence repeats across multiple symbols. See Table 14.
Pilot IQ file (symbol n):

Iant0’ Qant0’ Iant1’ Qant1’ Iant0’ Qant0’ Iant1’ Qant1’

(symbol n+1):

Iant1’ Qant1’ Iant0’ Qant0’ Iant1’ Qant1’ Iant0’ Qant0’

Table 14. Pilot IQ file for simplified Type 1 MIMO signal.
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Configuring Type 2 MIMO

This class of signals, where all preamble and all pilot subcarriers are transmitted on
all antennas, is represented by the following simplified example. Again, representing
these signals is handled within the configuration files as shown in this section.

Antenna 0

Antenna 1

Preamble

P x P x P x P x P x

P x P x P x P x P x

Symbol 1

1 0 0 0 0 0 1 0 0 0

1 0 0 0 0 0 1 0 0 0

Symbol 2

0 0 0 1 0 0 0 0 0 1

0 0 0 1 0 0 0 0 0 1

Symbol 3

1 0 0 0 0 0 1 0 0 0

1 0 0 0 0 0 1 0 0 0

Symbol 4

0 0 0 1 0 0 0 0 0 1

0 0 0 1 0 0 0 0 0 1

Table 15. Type 2 MIMO signal (simplified example). Notice how preamble (P) and pilot (1)
subcarriers are overlapping, i.e. active on both antennas simultaneously.

Resource Map file

Because the preamble and pilots are used simultaneously on both antennas, it is
not necessary to assign an antenna number. Instead, one further bit is used in the
Resource Map value to indicate that the given resource is present on all antennas.
This is bit #10, which means that a multi-antenna resource will have a value of (512
+ Resource Type).

Multi

Ant

Ant

Ant

User

User

User

Type

Type

Type

1

X

X

X

0

0

0

0

1

1

0 = No
1 = Yes

xxx = (value ignored)

000 = User 0 (default)
001 = User 1
010 = User 2 (etc.)

Table 16. Calculating Resource Map file values for Type 2 MIMO signals.
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000 = Data
001 = Pilot
011 = Preamble (etc.)

Examples Shown:
Resource type is 3
(= preamble subcarrier)
User number 0 (default)
Multi-antenna = yes
Resource map = 515
= (Multi x512) + Resource

For the simplified Type 2 MIMO signal shown in Table 16, the Resource Map would
be as shown in Table 17.
Resource Map
Preamble

515

0

515

0

515

0

515

0

515

0

Symbol n

513

0

0

0

0

0

513

0

0

0

Symbol n+1

0

0

0

513

0

0

0

0

0

513

Table 17. Resource Map file for simplified Type 2 MIMO example.

Repeat

Resource Modulation file

This file requires no modification. As before, it contains one Resource Modulation
value for each subcarrier shown in the Resource Map file.

Preamble and Pilot IQ files

Although the preamble and pilot subcarriers are present on both antennas simultaneously, they will generally not have the same I-Q values, so they must be specified separately.
In their respective IQ files, the complete set of IQ data for antenna 0 is provided first,
followed by the IQ data for antenna 1, and so on.
The 89600 VSA software assumes that the number of antennas to be analyzed is equal to
the number of hardware inputs currently selected on the 89600 VSA software’s Input >
Channels menu.
The Preamble IQ file for the simplified MIMO signal will thus include two lines, one for
antenna 0 and one for antenna 1. Each line contains the I-Q pairs that describe the five
preamble tones on that antenna. See Table 18.

Pilot IQ file (ant 0):

Iant0’ Qant0’ Iant0’ Qant0 ’Iant0’ Qant0’ Iant0’ Qant0’ Iant0’ Qant0

(ant 1):

Iant1’ Qant1’ Iant1’ Qant1’ Iant1’ Qant1’ Iant1’ Qant1’ Iant1’ Qant1

Table 18. Preamble IQ file for simplified Type 2 MIMO example signal.
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Likewise, the Pilot IQ file for this signal will contain data for two symbols on
antenna 0 (because of the two-symbol repeat sequence), followed by data for two
symbols on antenna 1. See Table 19.
Pilot IQ file (ant 0):

Iant0’ Qant0’ Iant0’ Qant0

symbol n

(ant 0):

Iant0’ Qant0’ Iant0’ Qant0

symbol n+1

(ant 1):

Iant1’ Qant1’ Iant1’ Qant1

symbol n

(ant 1):

Iant1’ Qant1’ Iant1’ Qant1

symbol n+1

Table 19. Pilot IQ file for simplified Type 2 MIMO example signal.

Summary

OFDM signals present a rich set of user benefits, as well as complex troubleshooting. The 89600 VSA software with Option BHF custom OFDM modulation analysis
provides a way to address both. Using easy-to-understand text-based files for signal
description, it allows designers of new, custom, or non-standard OFDM signals to
troubleshoot and analyze their signals. With simple extensions, the files also define
multiple-user or up to 4x4 MIMO signals, further increasing the range of signals
addressed.
This application note provides the user with descriptions and examples of each file.
For further information, see the 89600 VSA software Help text.
Used with any of the over 30 platforms supported, the 89600 VSA software with
Option BHF custom modulation analysis can analyze signals anywhere in the block
diagram. As it is software-based, test signals developed in MATLAB or other software program can be used prior to actual hardware measurements to easily validate
the 89600 VSA software demodulation setup, or to make measurements on the test
signal itself.
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Appendix A
Option BHF setup parameters
Data acquisition
Required configuration data

Symbol resource map, resource modulation type, preamble IQ, Pilot IQ

Supported subcarrier types

Data, pilot, unknown pilot, preamble, null

Resource modulation formats
supported

BPSK, QPSK, 8PSK, 16QAM, 32QAM, 64QAM, 128QAM, 256QAM, 512QAM, unknown

Input configuration file formats

.txt, csv

MIMO spatial streams supported

2x2, 3x3, 4x4

Adjustable parameters
Signal format parameters setup
Preset to standard

802.11a provided as example

Configuration file setup
Load pilot IQ values

Downloads text file listing pilot IQ values for each subcarrier/symbol combination

Load preamble IQ values

Downloads text file listing preamble IQ values for each subcarrier combination

Load resource map

Downloads text file listing subcarrier type, user ID, antenna number, all antennas for each
carrier/symbol combination

Load resource modulation

Text file listing expected constellation for each subcarrier in each symbol

Manual configuration parameters
FFT length

Get/set the FFT length used for OFDM transmission; must be a power of 2 up to 64K

Guard interval

Get/set the guard interval (cyclic prefix0

Guard lower subcarriers

Get/set the number of lower guard subcarriers which will be ignored for results

Guard upper subcarriers

Get/set the number of upper guard subcarriers which will be ignored for results

Mirror frequency spectrum

Enables/disables time-domain conjugation, which mirrors the frequency domain around the center
frequency

OFM system sample frequency

Get/set the OFDM FFT sample rate

Format details
Pilot IQ values

Specifies ideal I-Q values for each subcarrier identified as a pilot

Preamble IQ values

Specifies ideal I-Q values for each subcarrier identified as a preamble tone

QAM identifiers

Each entry provides index into QAMLevels array

QAM levels

Each entry in array specifies modulation type

Resource map

Specifies the subcarrier type for each

Resource modulation

Specifies modulation used on each resource (subcarrier/symbol time)

Resource repeat index

Tells the analyzer where to loop after it reaches the end of the Resource Map file; for resource maps
which include a repeating pattern of similarly-formatted symbols so that it is only necessary to
define the pattern once

Burst signal status

Specifies whether the signal is bursted (pulsed) or continuous

Number of transmitter antennas

Get/set the number of transmitter antennas; max 4

Transmitter window beta

Get/set how much windowing was used in the transmitter to smooth the transition between symbols

Boosting details

Advanced parameters for OFDMA systems
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Option BHF setup parameters (continued)
QAM identifier boost levels

Get/set the boost power level for each QAM identifier

Unknown pilot boost level

Get/set the boosting level used for unknown pilot subcarriers

User boost levels

Get/set the boost power level for each user

Time parameters

Accesses the signal capture configuration parameters used to select the pulse search length
and isolate a segment of the time record for further viewing and data analysis

Measurement interval

Get/set the time length, in symbols, of the measurement region used for computing and displaying
the trace data results

Measurement offset

Get/set the time offset, in symbols, to the measurement region used for computing and displaying
the trace data results

Result length

Get/set the maximum number of symbols analyzed, including preamble symbols

Result length selection

Enable/disable auto-determination of result length

Search length

Get/set the measurement acquisition length, in seconds

Pulse search details

Sets pulse search and automatic threshold status (on/off); sets pulse search threshold value in dB

Equalizer and tracking

Specifies equalizer and pilot tracking parameters

Equalizer training

Equalizer training using any/all of data, pilots, preamble

Equalizer details

Sets details of equalizer behavior

Averaging mode

Gets/sets averaging mode used when averaging equalizer across multiple symbols

Pilot tracking

Track any/all of amplitude, phase, timing

Advanced parameters

Accesses advanced parameters used to adjust demodulation measurements and displays

EVM normalized by reference

Specifies whether EVM calculations are normalized by the IQ Reference signal power

Extended frequency lock range

Get/set extended frequency lock range plus lock range width, in subcarriers

Symbol time adjustment

Get/set symbol time adjustment to adjust the “useful symbol time period” (TFFT) within the “OFDM
extended symbol time period” (TS)

Synchronization mode

Get or set the synchronization mode used when synchronizing to the signal, either time
correlation or cyclic prefix

Display parameters

Enables/disables the display of any/all: data subcarriers, EVM in %, pilot subcarriers, preamble
subcarriers, subcarrier color based on user ID, sync correlation in %, zero subcarriers

Normalize IQ traces

Enables/disables normalization of IQ Meas, IQ Ref, and Error Vector traces
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Appendix B
Option BHF available measurements
Measurement results
Channel data

These results are available for data appearing at channels 1 to n (n<4) of the measurement platform

CCDF

Displays the complementary cumulative distribution function (CCDF) for the selected input channel

CDF

Cumulative distribution function for the data in the measurement interval

Correction

Correction curve used to correct for the frequency response of the input hardware and input digital filtering

Instantaneous spectrum

Spectrum computed before data is averaged

PDF

Probability density function (PDF) of the signal

Raw main time

Raw time data read from the input hardware or playback file for the selected channel, prior to correction or
resampling

Search time

Time record data after resampling and time adjustment, used to search for the pulse (or burst)

Spectrum

Averaged Instantaneous Spectrum display

Time

Time record before digital demodulation and after pulse search

Demodulation data

These results are available for each spatial stream in MIMO systems

ChN channel frequency
response

Channel frequency response for the specified spatial stream and measurement hardware input channel X
(where X is the number of the channel)

ChN equalizer impulse
response

Equalizer impulse response between the selected data stream and input channel X (where X is the selected
channel)

ChN instantaneous channel
frequency response

Non-averaged ChX Ch Frequency Response trace data

ChN instantaneous equalizer impulse response

Non-averaged ChX Ch equalizer impulse response trace data

Common pilot error

Shows the difference between the measured and ideal pilot subcarrier symbols

Error vector spectrum

Computed difference between IQ Measured vector value and IQ Reference vector value, showing the signal
EVM vs. frequency (subcarrier), a complex value at each subcarrier for each OFDM symbol

Error vector time

Signal EVM vs. time (symbols); a complex value at each subcarrier at each symbol-time showing the
difference between IQ Meas and IQ Ref

IQ measured

Measured IQ symbol values of the subcarriers, with one complex value for each subcarrier for each symboltime in the burst

IQ reference

Reference IQ symbol values of the subcarriers, with one complex value for each subcarrier for each
symbol-time in the burst

RMS error vector spectrum

Computed difference between IQ Measured vector value and IQ Reference vector value, a complex value at
each subcarrier for each OFDM symbol. The RMS Error Vector Spectrum is the RMS average EVM for each
subcarrier for all symbols within the burst
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Option BHF available measurements (continued)
RMS error vector time

Average error vector magnitude at each symbol-time

Symbols

Demodulated symbol data (raw binary bits) for each OFDM symbol and subcarrier detected

Cross channel data

This data incorporates all input channels and provides data for MIMO measurements

MIMO channel frequency
response

Shows an overlay of all the individual Stream(X) Channel(X) Frequency Response trace data results
for the current MIMO measurement; enables easy viewing and comparison of each measurement
stream(X) channel(X) frequency response trace data result on a single display

OFDM burst info

Table showing what fields were detected in the burst along with EVM, power level, modulation
format, and number of resource units for each field

OFDM equalizer MIMO condition
number

Vector containing the “condition number” of the equalizer channel frequency response matrices; one
condition number value for each subcarrier

OFDM error summary

Table providing a wide range of error information per physical channel plus an average of all
channels

Additional
Resources

Literature

Web

89600 VSA software Opt BHF
Custom OFDM modulation analysis, Technical Overview, literature
number 5990-6625EN

www.keysight.com/find/89600VSA
www.keysight.com/find/wlan
www.keysight.com/find/mimo

89600 VSA software, Brochure,
literature number 5990-6553EN
89600 VSA software, Configuration
Guide, literature number 5990-6386EN
89600 VSA software Opt 200 Basic VSA
and Opt 300 Hardware Connectivity,
Technical Overview, literature number
5990-6405EN
Understanding the use of OFDM in
802.16, Keysight Measurement Journal,
literature number 5989-6649EN
Concepts of Orthogonal Frequency Domain Modulation, Microwave Journal,
Dave Whipple, Keysight Technologies:
http://www.mwjournal.com/2008/DownloadablePDFs/Whipple_OFDM_Keysight.
pdf
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